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MODELAGEM DIGITAL E PROTOTIPAGEM | PARTE 01MODELAGEM DIGITAL E PROTOTIPAGEM | PARTE 01MODELAGEM DIGITAL E PROTOTIPAGEM | PARTE 01MODELAGEM DIGITAL E PROTOTIPAGEM | PARTE 01    

Aula 01 de Rhinoceros: IntroduçãoAula 01 de Rhinoceros: IntroduçãoAula 01 de Rhinoceros: IntroduçãoAula 01 de Rhinoceros: Introdução    
1.1) Apresentação do Software 

- O Rhino é um software de modelagem Non-Uniform (NURBS) que vem sendo cada vez mais usado 
por profissionais da área de design, combinando a precisão dos tradicionais 
softwaresCAD/CAM com a flexibilidade da modelagem de curvas e superfícies, para poder 
criar objetos com formas simples ou complexas. O Rhino usa superfícies NURBS 
pararepresentar formas orgânicas com precisão, incluindo formas abertas, fechadas, com 
orifícios e sólidos (modelos fechados formados por superfícies coladas por suas arestas). 
Este software possibilita a modelagem direta das superfícies, permitindo que sólidos 
oumodelos possam ser separados, editados e acoplados novamente. E além de setrabalhar com 
malhas (mesh) para integração com outros softwares. Qualquer combinação de curvas, 
superfícies e sólidos pode ser editada. 
 
- O que é NURBS?É um tipo de estrutura de modelagem tridimensional que se trata da 
representação gráfica de uma função matemática, e podedefinir com precisão qualquer 
forma desde uma simples linha bidimensional, círculo, arco ou cubo até a mais complexa 
superfície ou sólido de forma orgânica tridimensional que sepossa imaginar. Devido a sua 
flexibilidade e precisão, a modelagem NURBS pode ser usadapara ilustrações, animações e 
para desenvolvimento e fabricação de produtos. 
 
- CAD e CAM: As siglas CAD e CAM significamComputer-aided Design e Computer-aided 
Manufacturing. As siglas são usadas como referência à utilização do computador 
comoferramenta de auxílio para várias funções relacionadas ao projeto e a produção, 
devido à capacidade do software de processar, arquivar e mostrar grande quantidade de 
dadosrepresentando o produto, ou parte dele, e suas especificações. Para produtos 
mecânicos,por exemplo, esses dados seriam modelos gráficos bidimensionais (desenhos 
técnicos) outridimensionais. 
 

Fonte: Fabio Siqueira D’AlessandriForti, “Apostila do curso Modelagem &Rendering com 
Rhino e Flamingo”. Disponível em http://pt.scribd.com/doc/44659341/Apostila-Rhinoceros-
3-2#scribd. Acesso em Março de 2015. 
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1.2)Escolha do Template: Meters  

1.3) Tipo de Arquivo: 3DM  

2.3) Apresentação da Interface 

 

 

- Barras Superiores: 
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- Existem 4 viewports por padrão, 3 delas mostramdiferentes vistas do desenho e a quarta 
mostra o desenho em perspectiva. No entanto, essas formas de visualização podem ser 
alteradas. 

 

 

-Clicando no centro das viewports e arrastando, pode-se ajustar o tamanho das vistas, 
priorizando algumas em detrimento de outras. 

 

 

-Clicando duas vezes no nome de uma viewport é possível maximizá-la por completo. Para 
voltar basta clicar duas vezes novamente. 

-Cada viewport possui uma seta ao lado do nome da vista. Clicando nesta seta, e indo na 
opção Set View, é possível modificar a vista, seja ela de topo, lateral ou outras. 

-As opções Wireframe, Shaded,Rendered, Ghosted, X-Ray, Technical, Artistic e Pen 
modificam o estilo do desenho. 
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1.4) Movimentos Básicos: 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

1.5) Configurando a malha quadriculada existente na s vistas: (Tools – Options) 

 

- PAM: Nas projeções ortogonais usa-se o Botão Direito 
do mouse. Na perspectiva usa-se Shift + Botão Direito do 
mouse.  
 

- ORBIT: Botão Direito do mouse na perspectiva 

- ZOOM DYNAMIC: Rodar o scrool do mouse. 

- ZOOM WINDOW: Seleciona a região que se quer 
ampliar. 

- ZOOM EXTENDS: Mostra uma visão geral de tudo o 
que foi projetado nas viewports. Com o Botão Esquerdo, 
o Zoom Extends serve apenas para a vista que se está 
usando. Com o Botão Direito, ele serve para todas as 
vistas. 

- ZOOM SELECTED: Clica-se na forma que se quer 
ampliar. 

- UNDO VIEW CHANGE: Volta o(s) zoom(s) efetuado(s) 
anteriormente. 
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-A opção Grid LineCount modifica o número de linhas da malha, ou seja o tamanho da 
malha.  

- A opção Minor grid LinesEvery dá a dimensão do lado de cada quadrado pequeno, que 
no caso é 1mm. 

-A opção Major LinesEvery mostra quantos quadrados pequenos formam um lado do 
quadrado maior. 
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1.6) Layers, atalhos e OSNAP 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

O comando EditLayers  
cria e edita as layers. Ao 
clicar neste comando 
aparecerá uma aba à 
esquerda. 

• Em “Layers” é possível 
criar novas layers. 

ATALHOS:  

Para ligar ou desligar o Grid : F7 

Para ligar ou desligar o Ortho : F8 

Para habilitar o Control Points : F10 

Para ligar ou deslilgar o Osnap : F9 

OSNAP:  

• END: ponto final da curva 

• NEAR: qualquer ponto da curval 

• POINT: um ponto 

• MIDPOINT: meio da curva 

• CENTER: centro de uma circunferência, arco, etc. 

• INTERSECTION: interseção de duas curvas 

• PERPENDICULAR: linha perpendicular 

• TANGENT: encostará tangente à outra curva (habilitar 
controlpoints F10) 

• QUADRANT: pega os quadrantes de um círculo  

• KNOT: Desenha à partir dos pontos 
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Circle : Criação de 
Círculos com diferentes 
lógicas (círculos a partir de 
2 pontos, por exemplo). 

Aula 01 de Rhinoceros: VolumesAula 01 de Rhinoceros: VolumesAula 01 de Rhinoceros: VolumesAula 01 de Rhinoceros: Volumes    
1.7) Volumes e Sólidos Básicos. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Elipse : Criação de elipse 
em várias lógicas como 
nos círculos. 

Arc : Criação de arcos em 
diferentes lógicas. 

Solid Creation:  Clicando na seta 
abaixo do cubo, abre-se uma aba 
com opções de criação de 
sólidos.  

 

Entre eles estão: Cone, Cilindro, 
Tronco de cone, Esfera e Pipe 
(que será detalhado mais à 
frente). 

Extrude : O comando 
extrude está localizado 
em uma outra caixa 
dentro da caixa 
SolidCreation. 

ExtrudeSurface  
(srf): com este 
comando é 
possível extrudar 
uma superfície e 
então formar um 
sólido. 

EstrudeClosed Planar 
Curves : Possibilita extrudar 
curvas e formar um sólido 

Rectangle : Criação de 
Retângulos em diferentes 
lógicas. 
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1.8) Comandos modificadores: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Split:  Corta duas peças que possuem uma interseção, assim como está ilustrado no 
processo abaixo: (Lembrando que este pode ser aplicado em superfícies ou volumes) 

 

  

 

 

 

Após afastar os sólidos temos: 

Move:  utilizado 
para deslocar 
um objeto. 

Rotate:  possibilita 
rotacionar um elemento. 

Scale:  possibilita redimensionar um 
objeto em escala tridimensional 
(proporcionalmente), bidimensional 
(mantem travada uma direção) e 
unidimensional (deforma). Além desses, 
temos o Scale Non-Uniform, que deforma 
cada direção de uma vez. 

Mirror:  possibilita 
espelhar um objeto 
a partir de um eixo. 

Twist: Este comando permite-nos 
torcer um objeto a partir de um 
eixo. 

Bend:  utilizado 
para “entortar” 
um objeto. 

Taper : permite-
nos afunilar uma 
parte de um 
sólido. (exemplo: 
turbina de avião) 
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- Trim:  Além de separar, o Trim apaga os objetos. Funciona da mesma maneira que no 
Autocad e também serve para superfícies e volumes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Cutting plane: Cria um plano para corte de uma peça bidimensional ou tridimensional. 

 

 

- Uma opção é utilizar um plano de corte 
(Cutting Plane) antes de dar os comandos Split 
ou Trim. 
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-Cap: Com esta ferramenta podemos “tampar” uma forma que possui extremidades 
abertas. 
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EXERCÍCIO EM SALA 01EXERCÍCIO EM SALA 01EXERCÍCIO EM SALA 01EXERCÍCIO EM SALA 01: : : : Cadeira RietveldCadeira RietveldCadeira RietveldCadeira Rietveld    
 

 

 

- Cadeira projetada em 1917 por GerritRietveld. Também 
chamada de “Blue andRedChair”, representa uma das primeiras 
manifestações do movimento De Stjil.  

- Com o auxílio dos dados técnicos abaixo, modele no 
Rhinoceros a cadeira de Rietveld. 

 

 

 

Disponível em: <http://pt.wikipedia.org/wiki/Cadeira_Vermelha_e_Azul>. Acesso em : 5 mar. 2015. 

Fonte: https://www.comvest.unicamp.br/vest2013/F2/provas/he/arquitetura2013.pdf- Acesso em Março de 2015 
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1 x Encosto (inclinado):    0.88m x 0.33m x 0.015m 

1 x Assento (inclinado):    0.45m x 0.36m x 0.015 

2 x Braço:                       0.45m x 0.09m 0.03m 

2 x Pé frontal:                  0.33m x 0.03m x 0.03m 

2 x Pé posterior:              0.47m x 0.03m x 0.03m 

2 x Pé lateral (não chega ao chão): 0.43m x 0.03m x 0.03m 

4 x Apoio horizontal:        0.60m x 0.03m x 0.03m 

1 x Apoio horizontal (fixado na parte superior ao encosto, na junção de braços e pés 
posteriores): 0.60m x 0.03m x 0.03m 

2 x Travessas laterais:    0.66m x 0.03m x 0.03m 

 

 

Comandos:  Move, Rectangle, Rotate e Cap  
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Cadeira Rietveld. Disponível em: <http://reager-.github.io/cg-final-
project/redandbluechair/images/rb_dimensions.png>. Acesso em 21 ago. 2016. 

 

 

Para mais cadeiras do arquiteto, acesse: http://www.rietveldoriginals.com/en/collection/. 
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EXERCÍCIO EXTRACLASSE 01EXERCÍCIO EXTRACLASSE 01EXERCÍCIO EXTRACLASSE 01EXERCÍCIO EXTRACLASSE 01: Família de formas: Família de formas: Família de formas: Família de formas    
 

A partir da família de formas presentes na Cadeira vermelha e azul, criar outras duas 
peças de um mobiliário. 

 

Exemplos de peças de mobiliário geradas a partir da noção de família de formas. 

 

 

Família de formas.  Fonte: Perrone e Vargas (2014, p.42). 

 

 

Família de formas.  Fonte: Perrone e Vargas (2014, p.41). 
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AulAulAulAula 02 de Rhinoceros: Curvasa 02 de Rhinoceros: Curvasa 02 de Rhinoceros: Curvasa 02 de Rhinoceros: Curvas  

Comandos relacionados à curvas 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

-Pipe : O comando Pipe localiza-se na caixa SolidCreation e possibilita a criação de “tubos” 
a partir de uma curva (que configura a trajetória deste tubo). Após isso, o comando exige 

Polilyne : Para construção de 
linhas com ângulos usamos a 
notação @comprimento da 
linha< ângulo da linha. Por 
exemplo: @13<22. Pra a 
construção de linhas através de 
coordenadas usa-se a notação 
@medida em x, medida em y. 
Exemplo: @12,5 

Curve : Desenha linhas 
curvas. Para terminar o 
desenha clica-se com o 
Botão Direito. 

Points On/Points Off: É 
possível, clicando na seta 
abaixo do símbolo, abrir a 
caixa Point Edit. 

 

Nos símbolos assinalados 
é possível, 
respectivamente, 
aumentar ou diminuir o 
número de pontos em 
uma curva. 

Edit Points On : (Atalho F10) 
habilita os pontos da curva e 
possibilita edita-la. 

Explode: Separa um 
elemento do outro. 
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dois diâmetros: um da circunferência inicial e outro da final. O resultado é uma forma como 
a demonstrada abaixo: 

 

 

 

- Loft: O comando Loft situa-se na caixa SurfaceCreation e constrói uma superfície a partir 
de duas curvas irregulares.O resultado é uma forma como a ilustrada a seguir:  
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-Explode : O comando explode tem atalho na aba lateral já exemplificada acima. Com 
este comando podemos separar os elementos de uma peça, como no exemplo abaixo: 

 

 

 

- Join: Possui lógica contrária ao explode, de modo que este une diferentes partes. 

 

 

-Revolve:  Para criação de sólidos de revolução, primeiramente faça uma curva, depois 
clique no comando em questão, indicado. Em seguida, crie o eixo de revolução, e 
rotacione para finalizar a forma, conforme exemplo abaixo. 

 

 

 

- Sweep 1 rail:  Assim como o revolve, este comando utiliza um perfil para compor uma 
forma, mas podemos definir a trajetória do mesmo, criando diferentes objetos. Com o 
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mesmo perfil acima e com uma trajetória elíptica, por exemplo, criou-se esta forma: 

 

 

 

 

-Sweep 2 rails:  Podemos elaborar objetos ainda mais sofisticados, utilizando dois 
caminhos para um perfil dado. A lógica é a mesma do comando anterior.  

 

 

 

 

 

- Patch: Pode ser usado para fechar sólidos que não são planos. Com o exemplo anterior, 
obteve-se o seguinte resultado: 
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- Extrudesurfacealong curve: Para extrudar uma forma ao longo de uma curva, basta usar 
este comando. No exemplo abaixo, o plano selecionado (em amarelo) foi extrudado ao 
longo de uma curva.  

- Rail Revolve: Este comando necessita de um perfil e uma trajetória, mas diferentemente 
do Sweep 1 Rail, é possível fazer um eixo inclinado ao longo do qual se forma o sólido. 
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- Curve Network: O comando Curve Network permite fechar um sólido a partir de perfis 
irregulares, como mostra as figuras abaixo. Ambas os perfis devem encostar em duas 
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curvas que vão delimitar sua trajetória. No caso exemplificado, esta trajetória é uma elipse. 
O atalho para este comando é “NetworfSrf”. 
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EXERCÍCIO EM SALA 02: EXERCÍCIO EM SALA 02: EXERCÍCIO EM SALA 02: EXERCÍCIO EM SALA 02: Igreja São Francisco de Igreja São Francisco de Igreja São Francisco de Igreja São Francisco de 

AssisAssisAssisAssis 

 

- Igrejaconstruída na década de 40, projeto deOscar 
Niemeyer. Também chamada de “Igreja da 
Pampulha”, é famosa por suas formas curvas e 
painéis de Cândido Portinari e Paulo Werneck. 

- Com o auxílio dos dados abaixo, modele no 
Rhinocerosesta famosa igreja de Oscar Niemeyer. 

 

 

 

 

 

 

 

 

 

 

 

 

Fonte: http://casandoembh.com.br/casamento-religioso-igreja-sao-francisco-de-assis 

Acesso em Abril de 2015 

Fonte: http://granadablogs.com/arquiculturaysociedad/2012/12/-Acesso em Março de 2015 

Fonte: PEREIRA, N. C. (2012).Concepção arquitetônica e estrutural de duas obras de Oscar Niemeyer: Igreja da Pampulha e Pavilhão da GameleiraDissertação de 

Mestrado em Estruturas e Construção Civil, Publicação E.DM012/12 Departamento de Engenharia Civil e Ambiental, Universidade de Brasília, Brasília, DF, 75p. 
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Fonte: PEREIRA, N. C. (2012).Concepção arquitetônica e estrutural de duas obras de Oscar Niemeyer: Igreja da Pampulha e Pavilhão da GameleiraDissertação de 

Mestrado em Estruturas e Construção Civil, Publicação E.DM012/12 Departamento de Engenharia Civil e Ambiental, Universidade de Brasília, Brasília, DF, 75p. 

Fonte: PEREIRA, N. C. (2012).Concepção arquitetônica e estrutural de duas obras de Oscar Niemeyer: Igreja da Pampulha e Pavilhão da GameleiraDissertação de 

Mestrado em Estruturas e Construção Civil, Publicação E.DM012/12 Departamento de Engenharia Civil e Ambiental, Universidade de Brasília, Brasília, DF, 75p. 



P á g i n a  | 25 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Comandos:Loft 

Extrude 

Surface Creation 

Cap 

Fonte: http://casandoembh.com.br/casamento-religioso-igreja-sao-francisco-de-assis - Acesso em Abril de 2015 

Fonte: http://casandoembh.com.br/casamento-religioso-igreja-sao-francisco-de-assis - Acesso em Abril de 2015 

Fonte: PEREIRA, N. C. (2012).Concepção arquitetônica e estrutural de duas obras de Oscar Niemeyer: Igreja da Pampulha e Pavilhão da GameleiraDissertação de 

Mestrado em Estruturas e Construção Civil, Publicação E.DM012/12 Departamento de Engenharia Civil e Ambiental, Universidade de Brasília, Brasília, DF, 75p. 
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Aula 02 de Rhinoceros: Aula 02 de Rhinoceros: Aula 02 de Rhinoceros: Aula 02 de Rhinoceros: Sólidos complexos e Sólidos complexos e Sólidos complexos e Sólidos complexos e 

extração de linhasextração de linhasextração de linhasextração de linhas    
 

1.10) Curve fromObject:  Nesta barra temos os comandos: 

 

DuplicateBorder 

DuplicateEdgesDuplicate Face Border  

 

ExtractWireframe 

Contour 

Silhouete 

ExtractIsocurve 

 

 

- DuplicateBorder: Eventualmente, se após fazer um sólido você apagou suas bairadas, 
com este comando é possível encontra-las novamente, assim como o exemplo abaixo. 
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- DuplicateEdges: Funciona na mesma lógica do comando anterior, mas neste caso o 
propósito e reencontrar as bordas. 

 

 

 

- ExtractWireframe : Mostra as linhas de formação de um sólido, a partir deste pronto.  
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É possível modificar o número de linhas que compõe esse wireframe indo em Edit -
>Rebuild. Então poderemos aumentar ou diminuir sua complexidade, como o exemplo 
abaixo: 

 

 

 

 

-Countour : A partir do contour é possível fatiar uma peça através de uma eixo escolhido e 
também delimitar a distância que haverá de uma linha à 
outra.
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- Silhouete : Extrai a silhueta de um sólido 

 

 

 

- Drape: Cobre uma área delimitada da mesma maneira que um tecido. 

 

 

 

- Extractisocurve:  Semelhante ao Contour, porém escolhe-se manualmente a posição da 
linha de contorno. 
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1.11) Solid Tools: 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

VariableRadiusFillet: Arredonda arestas desejadas 

 

 

 

 

 

BooleanIntersection:  

Extrai a interseção de dois 
sólidos 

Boolean Union:  

Une dois sólidos 

Booleandifference:  

“Subtrai” um sólido de outro 

Boolean Split:  

Separa a interseção dos 
sólidos 

Cap Planar Holes:  fecha 
(tampa) sólidos. ExtractSurface:  

Extrai a superfície do sólido 
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Variable Radius Chamfer: Dá o mesmo efeito, mas de forma plana. 
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Fonte: https://www.youtube.com/watch?v=-uU7uPMJy9M – Acesso em Março de 2015 

EXERCÍCIO EM SALA 03: EXERCÍCIO EM SALA 03: EXERCÍCIO EM SALA 03: EXERCÍCIO EM SALA 03: Catedral Catedral Catedral Catedral de Brasíliade Brasíliade Brasíliade Brasília    
Parte A : Modelagem da Catedral 

 

- Igreja projetada por Oscar Niemeyer com 
cálculo estrutural de Joaquim Cardoso com 
inauguração em 31 de Maio de 1970 em Brasília, 
próxima à esplanada dos ministérios. 

- Com o auxílio dos dados abaixo, modele no 
Rhinoceros a Catedral Metropolitana de Brasília. 

 

 

 
 

 

 

 

 

 

 

 

 

 

Fonte: http://pt.wikipedia.org/wiki/Catedral_Metropolitana_de_Bras%C3%ADlia - Acesso em Abril de 2015 
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- Com o auxílio do arquivo passado para os alunos teremos: 

(IMPORTANTE: Duplicar a curva do arquivo antes de tudo) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fonte: https://www.youtube.com/watch?v=-uU7uPMJy9M – Acesso em Março de 2015 
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2 Triângulos com valor vertical 0.3 

1 Triângulo com valor vertical 1 

1 Triângulo com valor Vertical 2 
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Comandos: Loft 

Sweep 1 Rail 

Polar Array 

Polygon 

Circle 

Extract Wireframe (opcional) 

Cutting Plane 

Trim 

 

 

Parte B : Modelagem do Campanário  
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*”Surfacefrom planar curves”, na aba SurfaceCreatio n. O Cap não funciona ao tentar 
fechar mais de 20 curvas.  
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Comandos: Polyline 

Surface from planar curves 

ExtrudeCrv 

Move 

Rotate 

Sweep 1 Rail  

Offset (opcional) 

Arc 

 

- Resultado Final: 
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MODELAGEM DIGITAL E PROTOTIPAGEM | PARTE 0MODELAGEM DIGITAL E PROTOTIPAGEM | PARTE 0MODELAGEM DIGITAL E PROTOTIPAGEM | PARTE 0MODELAGEM DIGITAL E PROTOTIPAGEM | PARTE 02222    

Aula 01 de Grasshopper: IntroduçãoAula 01 de Grasshopper: IntroduçãoAula 01 de Grasshopper: IntroduçãoAula 01 de Grasshopper: Introdução    

    
2.1)Apresentação do plug-in 

Para os designers que estão explorando novas formas usando algoritmos generativos, 
Grasshopper® é um editor algoritmo gráfico integrado com ferramentas de modelagem do 
softwareRhino 3D. Fonte: http://www.grasshopper3d.com/ 

 

2.2) Primeiras informações 

a)Abrindo o programa: basta digitar Grasshopper na barra de comandos do Rhinoceros 

b) Tipo de arquivo:  .gh 

c) Zoom: Redefinir na área mostrada abaixou ou scroll do mouse 
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d) Cores das Pilhas: As pilhas podem apresentar cor verde, laranja ou vermelho. Quando 
estiver verde, tudo está em ordem. Quando está laranja, a pilha está precisando de alguma 
informação. Se está vermelha, é porque foi utilizado o comando errado. 

 

e) Conexão das Pilhas: Para conectá-las, basta clicar em uma extremidade das mesmas 
e puxar para outra pilha. Para desconectá-las, fazemos o caminho inverso, apertando a 
tecla ctrl. É importante ressaltar que posicionando o mouse sobre as entradas e saídas das 
pilhas elas nos mostrarão as informações necessárias. 

 

f) Diferença entre parâmetro e componente: O parâmetro guarda uma informação, 
enquanto o componente executa uma ação. Para entendermos, faremos um primeiro 
exercício. 

Comandos que serão utilizados e sua localização: 

 

Params → Geometry →Circle  

Surface → Freeform →Extrude  

Vector →Constants →UnitZ  

Params → Special →Number Slider  

Surface → Util →CapHoles  

Curve →Primitive →Circle  (Componente) 

Vector → Constants →XZPlane 

Curve → Primitive →Rectangle  (Componente) 
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-Primeiramente criaremos uma pilha circle e “setaremos” a mesma. Basta clicar nela com o 

botão direito e clicar em set onecircle. 

 

- Depois criaremos as pilhas extrude, que irá me pedir a direção (unit Z) e o tamanho da 

extrusão (numberslider). A pilha numberslider pode ser configurada para números inteiros, 

decimais, etc; além de podermos alterar seu valor máximo e mínimo. Para isso, basta 

clicarmos com o botão direito na mesma e logo após em edit. 

-  

 

- Finalmente, basta criarmos uma pilha cap para tampar o objeto e conectá-la à saída da 

pilha extrude. 

-Desafio: Trocar pilha circle por pilha geometry, e mudar a geometria do objeto. 
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- Agora, criaremos objetos semelhantes, mas com a lógica de um componente. Basta 

trocarmos a pilha circle parâmetro pela pilha circle componente, que pede o plano do 

círculo e o raio do mesmo. 

 

 

-Desafio: Trocar pilha circle componente por pilha rectangle componente. 
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EXERCÍCIO EM SALA 04: EXERCÍCIO EM SALA 04: EXERCÍCIO EM SALA 04: EXERCÍCIO EM SALA 04: ComposiçõesComposiçõesComposiçõesComposições    
 

 

Curve → Primitive →Rectangle  

Vector → Grid →Populate 2D  

Mesh → Triangulation →Voronoi  

Surface → Freeform →Extrude  

Curve → Util →Project  

Params → Geometry →Brep  

Vector → vector →Unit Z  

Surface → Freeform →Pipe  

 

 

Lógica do exercício:  

Criação de uma pilha rectangle componente.  Utilizar pilha slider para dar as dimensões 

nos eixos X e Y. No caso usa-se uma mesma pilha para os dois eixos, formando então um 

quadrado. Extrudamos esse retângulo na direção Z, além de termos populado-o com 

pontos (Pop 2D). Podemos definir o número de pontos e a distribuição dos mesmos em N 

e S, respectivamente, da pilha Pop 2D. Criamos pilha Voronoi, que com os pontos criados 

fará o desenho desejado. Projetamos o resultado e demos um pipe, para dar espessura às 

linhas. 
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EXERCÍCIO EM SAEXERCÍCIO EM SAEXERCÍCIO EM SAEXERCÍCIO EM SALA 05: Cobertura LA 05: Cobertura LA 05: Cobertura LA 05: Cobertura com Voronóicom Voronóicom Voronóicom Voronói 

 

 

Params →Curve  

Curve → Division →Divide Curve  

Curve → Primitive →Arc 3pt  

Surface → Freeform →Loft  

 

Lógica do exercício: Criação de 3 spin lines no Rhinoceros. No grass, criamos 3 pilhas 

curve e “setamos” as spin lines. Criamos a pilha divide para cada uma das curvas, assim 

como uma slider para definir o numero de divisões. 

 

Depois, criamos a pilha loft, obtendo o resultado abaixo. Não aconteceu nada, pois 

estamos dando loft nas divisões. 
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Então, a partir dos pontos criados nas divisões, criamos uma pilha arco, que em seguida 

será conectada ao loft, obtendo o resultado esperado. 
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Para dar espessura às curvas, conectamos uma pilha pipe para cada pilha crv. 

 

Finalmente, para dar espessura aos arcos, criamos uma pilha pipe e uma slider para 

indicar a espessura. 

 

 

EXERCÍCIO 03 – Voronói + Cobertura  

Mesclar o Voronói à cobertura recém criada.  
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EXERCÍCIO EM SALA 0EXERCÍCIO EM SALA 0EXERCÍCIO EM SALA 0EXERCÍCIO EM SALA 06666: : : : Diagrid Diagrid Diagrid Diagrid  

 

Params → Geometry → Curve 

Surface → Freeform → Loft 

Params → Geometry → Surface  

Maths → Domain → Divide Domais² 

Surface → Util → Isotrim  (subsurface) 

Surface → Analysis → Brep Components  (explode) 

Sets → List → List Item (item) 

Surface → Freeform → 4 Point Surface (Srf4pt) 

Surface → Freeform → Pipe 

 

-Lógica do Exercício:Diagrid é uma espécie de malha que, neste caso poderá ser aplicada 

a uma superfície. No exercício, a partir de 2 curvas feitas no Rhinoceros e “setadas” no 

Grasshopper, temos o início do Diagrid. O comando Loft dá forma à superfície que se quer 

moldar através das curvas. Na sequência utiliza-se a pilha Subsurface e também a Explode 

para que cada divisão possa ser editada.  
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A partir daí criam-se 4 Itens, cada um representando um vértice das subdivisões da 

superfície (exemplo: vertíce A, B, C e D de cada unidade). Conectando-se Sliders a cada 

um desse Itens conseguimos numerá-los (0, 1, 2, 3). 
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 Em seguida conectamos 

2 a 2 (de maneira intercalada) estes Itens ao comando Line, além de também ligar todos 

os itens à uma superfície de 4 pontos (4PointSrf).  
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O comando Pipe liga-se às pilhas Line e Explode para que as linhas do Diagrid ganhem 

espessura. Ambos os Pipes devem estar ligados à Sliders que determinam o valor desta 

medida. 
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Pra finalizar podemos determinar um sólido para unir cada extremidade das unidades do 

Diagrid. Para isso deve-se conectar a figura escolhida (Circle, Rectangle...) e fazer as 

modificações necessárias (extrudar, colocar sliders, Cap...). 
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EXERCÍCIO EM SALA 0EXERCÍCIO EM SALA 0EXERCÍCIO EM SALA 0EXERCÍCIO EM SALA 07777: : : : Attraction PointsAttraction PointsAttraction PointsAttraction Points    
 

         Radial  (Radgrid) 

Vector → Grid → Hexagonal  (Hexgrid) 

  Rectangular  (Recgrid) 

Circle  

Curve → Primitive →  Rectangle 

                Polygon 

Curve → Analysis → CurveCP 

Params → Input → Gradiente  (slider gradiente) 

Vector → Colour → Custom Preview 

Surface → Freeform → Extrude 

Params → Curve  

 

-Lógica do Exercício: O exercício Attraction Points consiste em representar uma malha 

(grids), cujo formato fica à critério do aluno, e no seu interior polígonos de diferentes 

tamanhos (circulo, retângulo ou outro).  

 Tomando como exemplo a escolha do Recgrid, o primeiro passo é adicionar 

Sliders para determinar quantas subdivisões haverão nesta malha nos sentidos x e y (Ex e 

Ey) e, em seguida, determinar o tamanho de cada unidade em x e em y (Sx e Sy).  

 Na sequência adiciona-se o polígono e conecta-se ao Recgrid. Sendo assim é 

necessário adicionar mais Sliders para determinar o tamanho dos lados ou raio do 

polígono.  
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 Então extrudamos o polígono no eixo definido, neste caso o eixo Z (unit Z). 
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 Ao fim destes primeiros comandos, aplica-se o Cap para fechar os sólidos 

extrudados. 
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 O próximo passo é adicionar o comando CrvCP ao grid determinado e à um Curve 

que tenha sido “setado” no Rhinoceros.  
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 Liga-se então o CrvCP ao antigo Unit Z. Esta ação irá tornar os polígonos mais 

próximos da curva menores e, consequentemente, os mais afastados maiores. 
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 Para finalizar adiciona-se um Gradient e o conecta à 2 Sliders e ao CrvCP. Isso 

fará com que, além das diferenças de alturas, os polígonos obtenham cores diferentes de 

acordo com o Gradient escolhido. 

 

 

 

 

 

 

 

 

 


